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ИДЕОЛОГИЯ ALTIUM DESIGNER

Конкурентоспособность на внешнем и внутреннем рынке вновь создаваемой и модифицируемой радиоэлектронной 

аппаратуры (РЭА) определяется, во-первых, инновационной идеей её функционирования, во-вторых своевременным 

выходом на потребительский рынок. Сокращение сроков создания изделий, в основном достигается за счет сокращения 

времени на стадии проектирования, что в свою очередь, не должно отражаться на качестве проектируемого изделия.

Одним из самых трудоёмких этапов проектирования РЭА является этап проектирование печатных плат (ПП). Выбор 

программного инструмента проектирования (САПР) печатных плат напрямую определяет эффективность труда 

инженерного персонала.

Для решения задач проектирования ПП традиционно применялась программа P-CAD, развитие которой было 

приостановлено в 2006 году, а в 2008 году компания разработчик программы официально объявила о снятии её с 

производства и прекращении её поставки.

В замен системы P-CAD компания «Altium Limited» предлагает разработчикам свою флагманскую САПР «Altium Designer», 

использование которой позволяет проектировать современную конкурентоспособную РЭА характеризуемую 

сложными алгоритмами функционирования, достигаемые за счёт применения:

�� большого количества электронных компонентов (микроминиатюризация ЭРИ);

�� электронных компонентов высокой степени интеграции (многовыводные BGA);

�� применением высокоскоростных интерфейсов (DDR2, DDR3, LVDS и т.п.);

�� сложных конструкций ПП (многослойные ПП, скрытые и глухие переходные отверстия, гибко-жёсткие ПП).

Компания «Altium Limited» в рамках одной программы Altium Designer объединила:  

�� Схемотехническое проектирование;

�� Топологическое проектирование печатной платы; Управление проектными данными;

�� Создание и проверку правил и ограничений; 

�� Интеграция цепочек поставки;

�� Взаимодействие с MCAD-системами;

�� 	Формирование конструкторской документации; 

�� Формирование данных для производства.

Все эти элементы, интегрированы в единый интерфейс, что помогает пользователю просто и быстро переключаться 

между проектными задачами. При этом Altium Designer автоматически выводит команды и инструменты, необходимые 

для данной конкретной задачи.

30 летний опыт компании показывает, что это самый эффективный способ разработки электроники. Этот подход 

распространяется не только к индивидуальному инженеру, но и всей проектной группы. Несколько инженеров могут 

одновременно работать над различными аспектами одного и того же проекта, используя один и тот же интерфейс, при 

этом не расходуя время на перевод проектных данных между разными модулями разработки.
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ПОДГОТОВКА ФАЙЛОВ P-CAD

УСТАНОВКА IMPORT WIZARD

Перед началом подготовки трансляции файлов P-CAD в проектную среду Altium Designer, необходимо убедиться, 

в наличии установленного программного модуля импорта файлов формата P-CAD. Это может быть сделано 

непосредственно в Altium Designer, для этого нужно выполнить следующие действия:

1.	 Открыть Altium Designer

2.	 Выбрать команду File » Import Wizard

3.	 На экране приветствия нажать конку Next.

На следующем экране, ‘Select Type of Files to Import’, перечислены типы файлов доступных для импорта.

Выбор типа импортируемого файла в Altium Designer

В процессе инсталляции Altium Designer, можно выбирать программные модули импорта/экспорта для соответствующих 

типов файлов. 

При отсутствии записи «P-CAD Designs and Libraries Files» в списке, как показано выше, необходимо установить 

плагин импорта. Для добавления плагина требуется выполнить следующие действия:

1.   Выбрать Get More Importers в нижнем левом углу диалогового окна мастера импорта. Откроется вкладка 

Extensions & Updates (Расширения и обновления) в среде Altium Designer.

http://www.altium.com
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2.   Нажать кнопку ‘Configure’, откроеться окно Configure Platform (конфигурация программной платформы). 

3.   Прокрутить список установленных компонентов до раздела Importers\Exporters и установить флаг рядом с 

расширением P-CAD для его активации.

Включите импортер P-CAD в разделе Extensions & Updates

4.  Вернуться к началу списка и нажать ‘Apply’ (применить). Затем необходимо перезапустить Altium Designer, чтобы 

завершить установку программного модуля.

5.  Открыть раздел меню File» Import Wizard и убедиться, что модуль импорта P-CAD был установлен.

После добавления модуля импорта в Altium Designer, можно приступать трансляции файлов P-CAD.

ПОДДЕРЖИВАЕМЫЕ ВЕРСИИ P-CAD И ФОРМАТЫ ФАЙЛОВ 

Мастер импорта Altium Designer поддерживает версии файлов P-CAD 2000 и выше. Рекомендуется использовать 

последнюю версию P-CAD (P-CAD 2006).

Altium Designer раздел Extensions & Updates

http://www.altium.com
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ПЕРЕДАЧА СХЕМЫ P-CAD В ALTIUM DESIGNER

ПРОЦЕСС ПЕРЕДАЧИ ФАЙЛА СХЕМЫ ЭЛЕКТРИЧЕСКОЙ

1.	 Для запуска мастера импорта проектов, выполненных в сторонних системах, необходимо выполнить 
команду: File (вверху слева)» Import Wizard.

2.	 Откроется диалоговое окно мастера импорта, в котором будет предложено пошагово указать настройки 
импорта. Для перехода на следующий шаг необходимо нажать кнопку ‘Next>’ (Далее).

http://www.altium.com
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3.	 В области File Types (Типы файлов) необходимо указать формат импортируемых файлов, в данном 
случае P-CAD Design and Libraries Files (Файлы Проекта и Библиотеки). Для продолжения нажать 
кнопку ‘Next>’ (Далее).

4.	 На следующем шаге мастера импорта Importing P-CAD Design, предлагается выбрать файлы 
проекта для импорта, т.е. файлы схем (*.SCH). Нажать кнопку ‘Add’ (Добавить), чтобы перейти к выбору 
местоположению файла *.sch, который необходимо импортировать. После добавления файла окно 
мастера импорта будет выглядеть, как показано на рисунке ниже. Для продолжения нажать кнопку 
‘Next>’ (Далее).

!
Примечание: Импортируемые схемы и платы могут быть как независимыми разработками, так и 

частями одного проекта. В последнем случае после импорта необходимо восстановить ссылки 

между компонентами схемы и платы, т.к. по умолчанию файлы импортируются как независимые.

http://www.altium.com
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5.	 На следующем шаге импорта Importing P-CAD Libraries предлагается указать файлы библиотек для 
импорта в формате *.LIB. Для добавления библиотек P-CAD, нажать кнопку ‘Add’ (Добавить), чтобы 
выбрать файл(ы) библиотеки, который требуется импортировать. Для перехода на следующий шаг 
необходимо нажать кнопку ‘Next>’ (Далее).

! Примечание: Более подробно импортирование библиотек описано ниже в разделе «Передача 

библиотек компонентов»

6.	 После недолгого анализа выбранных файлов, предлагается установить дополнительные настройки 
импорта. На шаге PCB Footprint Naming Format, предлагается указать формат имени посадочного 
места (Footprint). Представленные настройки не относятся к схеме и описаны ниже. Для продолжения 
нажать кнопку ‘Next>’ (Далее).

7.	 На шаге Reporting Options предлагается включить проверку и вывод отчетов по результатам импорта. 
Делать это не обязательно, т.к. рекомендуется выполнять верификацию по результатам импорта как 
отдельную процедуру индивидуально с каждым файлом. Рекомендуется включить опцию «Do not 
translate hidden net names», так как она отключает передачу системных названий цепей (например: 
NET00001) в виде инструмента «Net label» (метка цепи). Для продолжения нажать кнопку ‘Next>’ (Далее).

http://www.altium.com
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8.	 На шаге Output PCB Projects показана структура проектов, которые будут сформированы по результатам 
импорта, где можно указать входимость файлов в разные проекты и задать директорию для сохранения 
результатов. 

9.	 На этом завершается процесс импорта, о чем свидетельствует сообщение P-CAD Import Wizard is 
complete. После нажатия кнопки Finish, результат импорта можно наблюдать в панели Projects, где 
будет сформирована структура проектов Altium Designer, в соответствии с ранее заданными настройками.

10.	 Автоматически может быть запущена панель Messages, которая обеспечивает интерактивный список 
сообщений об ошибках и предупреждения полученных после импорта. Это диалоговое окно можно 
закрыть, нажав на “х” в правом верхнем углу диалогового окна.

http://www.altium.com
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ВЕРИФИКАЦИЯ СХЕМЫ 

При импорте схем из программы P-CAD, могут появиться несовпадения конечного файла и оригинала. Чаще всего такое 

поведение связано с несовместимостью структур данных между двух систем автоматизированного проектирования 

и некорректным использованием инструментов в программе P-CAD. Во всех подобных случаях, редактирование 

рекомендуется выполнять в Altium Designer, т.к. здесь для этой задачи имеется более широкий инструментарий.

В этом разделе рассмотрены общие направления редактирования схемы, на которые стоит обратить внимание после 

импортирования схем из P-CAD. Для этого и последующих разделов верификации, предполагается, что пользователь 

имеет базовое навыки работы в Altium Designer. Для того, чтобы изучить основы Altium Designer, воспользуйтесь 

«Российская документация Altium Designer» на сайте wiki.altium.com.

Для получения дополнительной информации о редактировании нескольких объектов, пожалуйста, обратитесь к 

следующей ссылке:

http://techdocs.altium.com/display/ADOH/Editing+Multiple+Objects

КОМПИЛЯЦИЯ ПРОЕКТА

Компиляция выполняется для обнаружения ошибок в схеме. Прежде чем выполнить компиляцию, необходимо 

настроить ее правила, которые после импорта установлены по умолчанию, и являются недостаточными (не 

гарантируют корректность схемы!).

Для настройки правил компиляции, необходимо открыть: Project>Project Options, и включить нужные пункты на 

закладке Error Reporting.

В целом настройки компиляции можно оставить по умолчанию, дополнительно включив следующие пункты:

�� Floating Net Label = Fatal Error, Неподключенные метки цепей

�� Floating Power Object = Fatal Error, Неподключенные порты питания

�� Net with multiple names = Fatal Error, Цепь содержащая несколько наименований

�� Net with no driving source = No Reporting, цепь, не имеющая источника сигнала

�� Net with only one pin = Fatal Error, цепь содержащая только один вывод

http://www.altium.com
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После этого следует выполнить компиляцию проекта: Project>Compile PCB Project, и исправить все ошибки 

(сообщения со статусом Error и Fatal Error).

ЛИШНИЙ ЛИСТ СХЕМЫ

При импорте многолистового проекта, каждый лист схемы сохраняется в Altium Designer в виде отдельного файла. 

Кроме того создается отдельный лист с названием First_Sheet.SCHDOC, которого не было в схеме P-CAD. На этом листе 

изображены зеленые блоки, каждый из которых имеет ссылку на один из листов схемы. Если в первоначальной схеме 

не было иерархии, то такой лист можно удалить в проекте, при этом сам проект никак не пострадает.

ТОЧКИ ПРИВЯЗКИ ТЕКСТА

Практически все надписи на схеме имеют точку, показывающую графически местоположение точки привязки текста. 

Отображение точек можно отключить в настройках: DXP>Preferences>Schematic>Graphical Editing, Mark Manual 
Parameters. 

ПЕРЕВЕРНУТЫЕ НАДПИСИ

Многие тексты на схеме могут оказаться перевернутыми после импорта, хотя на схеме в P-CAD они не выглядели 

перевернутыми. Если внимательно посмотреть свойства таких надписей в редакторе схем P-CAD, то окажется, что у 

них в свойствах задан угол поворота 180 градусов.

http://www.altium.com
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Перевернуть все надписи в Altium Designer можно одним действием. Для этого необходимо сначала выделить все 

типовые надписи во всех листах проекта, а затем исправить их свойства.

После нажатия кнопки ОК в панели Find Similar Object, откроется панель Inspector, в которой нужно выполнить 

редактирование. Сначала нужно убедиться, что панель Inspector работает со всеми листами проекта [1] и [3], а затем 

изменить ориентацию надписей [2].

Для выделения одинаковых надписей во всех листах проекта, используется панель Find Similar Object, вызвать 

которую можно из контекстного меню, при нажатии правой клавишей на одной из надписей. Вызов данной панели 

после нажатия правой клавишей на надписи, загружает свойства данной надписи в одноименное окно запроса.

В панели Find Similar Object необходимо указать критерии поиска [1], включить опцию Select (Выделение) [2] и 

указать, что выделение должно быть выполнено во всех открытых листах [3].

http://www.altium.com
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ЛИШНИЕ МЕТКИ ЦЕПИ

Все цепи, которые не имели пользовательского названия в P-CAD, будут иметь метки цепей в Altium Designer, с именами 

«по умолчанию».

Такие метки можно удалить, причем сделать это можно одним действием, для каждого листа схемы, используя тот же 

инструмент, как и в предыдущем случае.

http://www.altium.com
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В качестве запроса поиска будет использоваться маска имени цепи: NET00*, после выделения всех аналогичных меток 

их можно удалить клавишей DELETE.

УТОЛЩЕННЫЕ ЛИНИИ УГО 

Такое отображение связано с тем, что в ALtium Designer толщина линии задается условно, а в P-CAD можно было 

задавать абсолютные (числовые) значения. Если в P-CAD толщина двух линий отличалась на 0,5мм (например, линия 

0,2мм и линия Default=0,254мм), то в Altium Designer это воспринимается как два разных значения Small (тонкая) и 

Medium (средняя).

Для решения такой проблемы, необходимо откорректировать графику УГО в библиотеке, и передать изменения в схему. 

Для этого, можно сформировать библиотеку из компонентов текущего проекта:  Design>Make Schematic Library.

В библиотеке можно глобально найти все линии нужной толщины, и отредактировать их, задав нужное значение. При 

этом можно использовать Find Similar Object и Inspector, описанные выше.

После редактирования компонента, необходимо в списке компонентов (панель SCH Library) нажать правой кнопкой 

мыши и выбрать Update Schematic Sheet.

http://www.altium.com


www.altium.com

ПЕРЕВОД  ДАННЫХ P-CAD В ALTIUM DESIGNER

15

ПЕРЕДАЧА ПЛАТЫ P-CAD B ALTIUM DESIGNER

ПРОЦЕСС ТРАНСЛЯЦИИ ФАЙЛА ПЕЧАТНОЙ ПЛАТЫ

1.	 Для запуска мастера импорта проектов, выполненных в сторонних системах, необходимо выполнить 
команду: File (вверху слева)» Import Wizard.

2.	 Появится диалоговое окно мастера импорта, в котором будет предложено пошагово указать настройки 
импорта. Для перехода на следующий шаг необходимо нажать кнопку ‘Next>’ (Далее).

http://www.altium.com
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3.	 В области File Types (Типы файлов) необходимо указать формат импортируемых файлов, в данном 
случае P-CAD Design and Libraries Files (Файлы Проекта и Библиотеки). Для продолжения нажать 
кнопку ‘Next>’ (Далее).

4.	 На следующем шаге мастера импорта Importing P-CAD Design, предлагается выбрать файлы 
проекта для импорта, т.е. файл платы (*.PCB). Нажатькнопку ‘Add’ (Добавить), чтобы перейти к выбору 
местоположения файла *.pcb, который необходимо импортировать. Файл будет выглядеть, как показано 
на рисунке ниже. Для продолжения нажать кнопку ‘Next>’ (Далее).

5.	 На следующем шаге импорта Importing P-CAD Libraries предлагается указать файлы библиотек для 
импорта в формате *.LIB. Для добавления библиотек P-CAD, нажмите кнопку ‘Add’ (Добавить), чтобы 
выбрать файл(ы) библиотеки, который вы хотите импортировать. Для перехода на следующий шаг 
необходимо нажать кнопку ‘Next>’ (Далее).
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6.	 После недолгого анализа выбранных файлов, предлагается установить дополнительные настройки 
импорта. На шаге PCB Footprint Naming Format, предлагается указать формат имени посадочного 
места (Footprint). Представленные настройки относятся к библиотекам посадочных мест компонентов и 
описаны ниже. Для продолжения нажать кнопку ‘Next>’ (Далее).

! Примечание: Более подробно импортирование библиотек описано ниже в разделе «Передача 

библиотек компонентов»
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8.	 На следующем шаге Current Layer Mapping предлагается указать соответствие слоев в программе 
P-CAD и в Altium Designer. Все немеханические слои определяются автоматически.

9.	 На шаге Output PCB Projects показана структура проектов, которые будут сформированы по результатам 
импорта, где можно указать входимость файлов в разные проекты и задать директорию для сохранения 
результатов. Для продолжения нажать кнопку ‘Next>’ (Далее).

7.	 На шаге Reporting Options предлагается включить проверку и вывод отчетов по результатам импорта. 
Делать это не обязательно, т.к. рекомендуется выполнять верификацию по результатам импорта как 
отдельную процедуру индивидуально с каждым файлом. Рекомендуется включить опцию «Do not 
translate hidden net names», так как она отключает передачу системных названий цепей (например: 
NET00001) в виде инструмента «Net label» (метка цепи). Для продолжения нажать кнопку ‘Next>’ (Далее).
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!
Примечание: Рекомендуется заранее продумать назначение механических слоев в программе 

Altium Designer, в том числе использовать один из таких слоев для контура платы, для сборочного 

чертежа и т.д. В данном примере, для контура платы используется слой Mechanical 1, и в него 

информация передается со слоя Board

10.	 На этом завершается процесс импорта, о чем свидетельствует сообщение P-CAD Import Wizard is 
complete. После нажатия кнопки Finish, результат импорта можно наблюдать в панели Projects, где 
будет сформирована структура проектов Altium Designer, в соответствии с ранее заданными настройками.
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ВЕРИФИКАЦИЯ ПЛАТЫ 

При импорте платы из программы P-CAD, могут появиться несовпадения конечного файла и оригинала. Чаще всего такое 

поведение связано с несовместимостью структур данных между двух систем автоматизированного проектирования. 

Чтобы убедиться в корректности передачи данных, в редакторе плат необходимо выполнить проверку правил 

проектирования. Прежде чем проверить правила рекомендуется сделать подготовительные действия.

Design>Rules. Правила проектирования. После импорта правила передаются в том виде, в котором они были заданы 

в P-CAD. При этом правила передаются в виде массива правил, применимых к разным парам объектов. Чаще всего, 

такие правила дублируют друг друга, и не имеют смысла, поэтому рекомендуется после импорта импортировать файл 

с ранее созданными правилами проектирования.

Для импорта правил, необходимо нажать правой клавишей в списке правил, и выбрать Import Rules.
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По результатам проверки в плате будут обнаружены «артефакты», которые описаны ниже.

В этом разделе рассмотрены общие направления редактирования платы, на которые стоит обратить внимание после ее 

импортирования из P-CAD. Описанный раздел верификации, предполагается, что пользователь имеет базовое навыки 

работы в Altium Designer. Для того, чтобы изучить основы Altium Designer, воспользуйтесь «Российская документация 

Altium Designer» на сайте wiki.altium.com.

Для получения дополнительной информации о редактировании нескольких объектов, пожалуйста, обратитесь к 

следующей ссылке:

http://techdocs.altium.com/display/ADOH/Editing+Multiple+Objects

КОНТУР ПЛАТЫ 

После импорта, размеры и контур платы не будут соответствовать оригиналу. Программа автоматически строит 

прямоугольную плату, размеры которой минимально описывают все объекты, которые находятся в импортированном 

документе. Чтобы вернуть плате исходный контур необходимо выбрать его (в данном примере контур платы был 

импортирован в 1 механический слой) и запустить команду Design>Board shape>Define from selected objects.

Tools>Design Rule Check, закладка Rules To Check. Здесь необходимо включить правила, которые будут проверяться 

в режиме OnLine, и при пользовательской проверке. Рекомендуется для режима OnLine включить только два правила 

Clearance и Component Clearance, а остальные проверять только в конце работы.
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НЕ КОРРЕКТНЫЙ РАЗМЕР ШРИФТА

После импорта из P-CAD тексты будут иметь шрифт, заданный по умолчанию. Это связано с тем, что Stroke шрифты, 

встроенные в P-CAD, и аналогичные, встроенные в Altium Designer отличаются! Если в P-CAD использовались True Type 

шрифты, то проблемы при конвертации в Altium Designer не будет.
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Если имеется данная проблема, то можно на плате выбрать все надписи и глобально отредактировать их параметры. 

Для выделения надписей используется панель Find Similar Object, а для редактирования Inspector.

ПОРЯДОК ЗАЛИВКИ ПОЛИГОНОВ

Порядок может не совпадать с тем, который был в начальном файле. В таком случае, большой полигон будет залит по 

всей плате, и полигоны меньшего размера, будут показаны в списке ошибок при проверке DRC, как не разведенные 

цепи. В Altium Designer порядок заливки полигонов определяет пользователь.

Для изменения порядка заливки полигонов используется команда Tools>Polygon Pour>Polygon Manager
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ПЕРЕДАЧА БИБЛИОТЕК КОМПОНЕНТОВ

КОНЦЕПЦИЯ БИБЛИОТЕК В ALTIUM DESIGNER

Идеология библиотек Altium Designer отличается от концепции в P-CAD, начинивая с того, что существует несколько 

различных вариантов организации библиотеки.

Основная идея, заключается в том, что символ (условно графическое обозначение компонента), созданный в редакторе 

символов, по сути, является компонентом. Атрибуты компонента – это атрибуты символа. К такому компоненту могут 

быть подключены модели для реализации в соответствующих прикладных областях: Footprint – для печатной платы, 

IBIS – для анализа целостности сигналов, Spice – для моделирования.

Создавая такую концепцию, Altium, решал задачу максимально упростить процесс разработки, при условии, что весь 

проект будет вести один разработчик. Такую идеологию используют многие пользователи, создавая новые библиотеки 

под каждый проект.

ПРОЦЕСС ПЕРЕДАЧИ БИБЛИОТЕК 

1.	 Для запуска мастера импорта библиотек, выполненных в сторонних системах, необходимо выполнить 
команду: File (вверху слева)» Import Wizard.
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3.	 В области File Types (Типы файлов) необходимо указать формат импортируемых файлов, в данном 
случае P-CAD Design and Libraries Files (Файлы Проекта и Библиотеки). Для перехода на следующий 
шаг необходимо нажать кнопку ‘Next>’ (Далее).

4.	 На следующем шаге мастера импорта Importing P-CAD Design, предлагается выбрать файлы проекта 
для импорта. Данный шаг является не обязательным, в случае импорта библиотек. Процедура импорта 
схемы и платы описана выше. Для продолжения нажать кнопку ‘Next>’ (Далее).

2.	 Появится диалоговое окно мастера импорта, в котором будет предложено пошагово указать настройки 
импорта. Для продолжения нажать кнопку ‘Next>’ (Далее).
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5.	 На следующем шаге импорта Importing P-CAD Libraries предлагается указать файлы библиотек для 
импорта в формате *.LIB. В нижней части окна необходимо выбрать конечный формат импортируемой 
библиотеки. Сохранение библиотеки после импорта возможно в виде интегрированной библиотеки 
(Integrated Libraries) или в виде базы данных (DbLib). Сохранение в формате DbLib является более 
предпочтительным, но требует предварительно изучения, поэтому для начала стоит выполнить 
сохранение в формате интегрированных библиотек.  Для добавления библиотек P-CAD, нажмите кнопку 
‘Add’ (Добавить), чтобы выбрать файл (ы) библиотеки, который вы хотите импортировать. Для перехода 
на следующий шаг необходимо нажать кнопку ‘Next>’ (Далее).

6.	 После недолгого анализа выбранных файлов, предлагается установить дополнительные настройки 
импорта. На шаге PCB Footprint Naming Format, предлагается указать формат имени посадочного 
места (Footprint). По умолчанию, предлагается называть посадочное место в формате, содержащем:

�� Component Name, наименование компонента,

�� Pattern Name, наименование посадочного места в P-CAD,
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�� Pattern Graphics, наименование варианта отображения посадочного места.

�� Рекомендуется, оставить в имени посадочного места только Pattern Name, убрав при этом все специальные символы, 

которыми предлагалось разделять составное наименование посадочного места. Для продолжения нажать кнопку 

‘Next>’ (Далее). 

!

Примечание: При импорте библиотеки, в которой посадочные места (Pattern) имели несколько 

вариантов отображения (Pattern Graphics), необходимо выполнять импорт посадочных мест 

отдельно от компонентов и символов. Для этого придется в программе P-CAD, скопировать все 

посадочные места в отдельную библиотеку, чтобы в ней не содержались символы и компоненты. 

Если это не предусмотреть, то по результатам импорта будут переданы только отображения 

посадочных мест, используемые по умолчанию (Pattern Graphics = Primary).

7.	 На следующем шаге Schematic Component Naming Format показано, как будут именоваться символы, 
без возможности редактирования формата их имени.
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!

Примечание: В случае сохранения библиотеки в виде интегрированной, символ и компонент 

будут являться единым объектом, с общим именем. Хранение и повторное использование 

символов в таком случае не предполагается. Если же библиотека будет сохранена в виде базы 

данных, тогда имена символов, будут соответствовать аналогичным названиям в P-CAD, и будут 

храниться отдельно.

8.	 На шаге Reporting Options предлагается включить проверку и вывод отчетов по результатам импорта. 
Делать это не обязательно, т.к. рекомендуется выполнять верификацию по результатам импорта как 
отдельную процедуру индивидуально с каждым файлом. Для продолжения нажать кнопку ‘Next>’ (Далее).

9.	 На следующем шаге Current Layer Mapping предлагается указать соответствие слоев в программе 
P-CAD и в Altium Designer. Все немеханические слои сопоставляются автоматически.
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10.	 На шаге Output Integrated Libraries показана структура проектов библиотек, которые будут 
сформированы по результатам импорта, где можно указать принадлежность файлов в разные проекты 
библиотек и задать директорию для сохранения результатов. Для перехода на следующий шаг 
необходимо нажать кнопку ‘Next>’ (Далее)

11.	На этом завершается процесс импорта, о чем свидетельствует сообщение P-CAD Import Wizard is 
complete. После нажатия кнопки Finish, результат импорта можно наблюдать в панели Projects, где будет 
сформирована структура библиотек Altium Designer, в соответствии с ранее заданными настройками.
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СИНХРОНИЗАЦИЯ ИМОРТИРОВАННЫХ ПРОЕКТОВ
Импортируемые схемы и платы могут быть как независимыми разработками, так и частями одного проекта. В последнем 

случае после импорта придется восстановить ссылки между компонентами схемы и платы, т.к. по умолчанию файлы 

импортируются как независимые.

После импорта проектов из сторонних систем необходимо выполнить синхронизацию, которая заключается в 

восстановлении ссылок между платой и схемой. 

Синхронизация проекта выполняется для того, чтобы схемы проекта и плата могли в дальнейшем использоваться как 

единый проект. По умолчанию, между импортированными схемой и платой будет отсутствовать взаимосвязь, несмотря 

на то, что они будут помещены в общий проект. При попытке внесения изменений в таком проекте, постоянно будут 

выдаваться сообщения о рассогласованности проекта, а также в результате изменений компоненты будут удаляться с 

платы и добавляться в свободном месте, вместо того, чтобы обновляться на своих местах в плате.

Синхронизация настраивается в редакторе плат, с помощью команды: Project>Component Links.

В окне Edit Component Links between…, показаны три списка:

•	 Слева, компоненты, которые есть в схеме, и не согласованы с платой,

•	 В центре, компоненты, которые есть в плате, и не согласованы со схемой,

•	 Справа, согласованные компоненты.

В импортированном проекте все компоненты будут не согласованы, и их согласование можно выполнить автоматически, 

по одному или нескольким критериям, указанным в нижней части данного окна:

•	 Designator, по позиционному обозначению,

•	 Comment, по наименованию,

•	 Footprint, по топологическому посадочному месту.

Для большинства проектов достаточно выполнить согласование только по критерию Designator, для чего нужно 

нажать кнопку Add Pairs Matched By.

http://www.altium.com


www.altium.com

ПЕРЕВОД  ДАННЫХ P-CAD В ALTIUM DESIGNER

31

После того, как компоненты на схеме и компоненты на плате получили соответствующие ссылки, проект является 

согласованным. Теперь необходимо убедиться, что схема соответствует плате, с точки зрения списка соединений. Для 

этого необходимо выполнить обновление проекта их схемы в плату, для чего необходимо, открыть любую из схем 

проекта, выполнить команду Design> Update PCB Document…

При обновлении предлагается подтвердить список вносимых изменений Engineering Change Order. Необходимо 

проанализировать данный список на предмет вносимых изменений. Если суть вносимых изменений не понятна, или 

изменение не является обязательным, то его можно отключить.

Для завершения внесения изменений, необходимо последовательно нажать кнопки Validate Changes и Execute 
Changes.

После проделанных манипуляций, схема полностью соответствует плате, и проект может в дальнейшем разрабатываться 

в Altium Designer.
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ABOUT ALTIUM

Altium LLC (ASX: ALU) is a multinational software corporation headquartered in San Diego, California, that focuses on electronics 

design systems for 3D PCB design and embedded system development. Altium products are found everywhere from world 

leading electronic design teams to the grassroots electronic design community.

With a unique range of technologies Altium helps organisations and design communities to innovate, collaborate and create 

connected products while remaining on-time and on-budget. Products provided are Altium Designer®, Altium Vault®, 

CircuitStudio®, PCBWorks®, CircuitMaker®, Octopart®, Ciiva® and the TASKING® range of embedded software compilers.

Founded in 1985, Altium has offices worldwide, with US locations in San Diego, Boston and New York City, European locations 

in Karlsruhe, Amersfoort, Kiev and Zug and Asia-Pacific locations in Shanghai, Tokyo and Sydney. For more information, visit  

www.altium.com. You can also follow and engage with Altium via Facebook, Twitter and YouTube.

ВАШИ СЛЕДУЮЩИЕ ШАГИ В ALTIUM DESIGNER
После того, как все ваши файлы успешно переведены с P-CAD, настало время, глубже погрузиться в тонкости единой 

среды разработки Altium Designer. Ниже приведены несколько ссылок на документацию, видео-уроки, а также 

дополнительные учебные ресурсы, которые помогут вам повысить опыт работы в Altium Designer.

ДОКУМЕНТАЦИЯ

�� Начало работы - На этой странице представленна группа ссылок на обучающие программы, каждая из которых 

связана с определенной областью проектирования.

�� Что нового в Altium Designer – набор статей описывающие новые функциональные возможности, появившиеся в 

Altium Designer.

�� Библиотеки компонентов – концепция, создание и управление библиотеками компонентов в Altium Designer.

Это лишь небольшая выборка из огромного архива Российской конструкторской документации Altium. Узнайте больше 

на wiki.altium.com

БИБЛИОТЕКА ВИДЕО 

Наш полный набор видео Altiumlive Video Library включает в себя несколько учебных пособий, тематические обзоры и 

многое другое, которые помогут познакомиться со средой Altium Designer. 

НУЖНА ДОПОЛНИТЕЛЬНАЯ ПОМОЩЬ?

При наличие вопросов по алгоритму перевода данных, обратитесь в службу технической поддержки компании «Altium».

www.altium.com
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